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Notice 

The company reserves the right to revise this publication or to change its contents 
without notice. Information contained herein is for reference only and does not 
constitute a commitment on the part of the manufacturer or any subsequent vendor. 
They assume no responsibility or liability for any errors or inaccuracies that may 
appear in this publication nor are they in anyway responsible for any loss or damage 
resulting from the use (or misuse) of this publication. This publication and any 
accompanying software may not, in whole or in part, be reproduced, translated, 
trans¬mitted or reduced to any machine readable form without prior consent from the 
vendor, manufacturer or creators of this publication, except for copies kept by the user 
for backup purposes. Brand and product names mentioned in this publication may or 
may not be copyrights and/or registered trade¬marks of their respective companies. 
They are mentioned for identification purposes only and are not intended as an 
endorsement of that product or its manufacturer. ©May 2006 

Trademarks 

This product incorporates copyright protection technology that is protected by 
method claims of certain U.S. pat¬ents and other intellectual property rights owned 
by Macrovision Corporation and other rights owners. Use of this copyright protection 
technology must be authorized by Macrovision Corporation, and is intended for 
home or other limited viewing uses only unless otherwise authorized by Macrovision 
Corporation. Reverse engineer¬ing or disassembly is prohibited. AMD Turion™ is a 
trademark of Advanced Micro Devices, Inc.

  is a trademark of SRS Labs, Inc. WOW technology is incorporated under license 
from SRS Labs, Inc. 
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Preface

FCC Statement (Federal Communications Commission) 

This equipment has been tested and found to comply with the limits for a Class 
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency energy 
and, if not in¬stalled and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined 
by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 

 

• Re orient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to   
 which the receiver is connected. 

• Consult the service representative or an experienced radio/TV technician for   
 help. 

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or 
modifications not expressly approved by the manufacturer for compliance with the above standards could void 
your authority to operate the equipment.
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IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, 
electric shock, and injury to persons when using any electrical equipment: 

1. Do not use this product near water, for example near a bath tub, wash bowl,   
 kitchen sink or laundry tub, in a wet basement or near a swimming pool. 

2. Avoid using this equipment with a telephone line (other than a cordless type)  
 during an electrical storm. There may be a remote risk of electrical shock from  
 lightning. 

3. Do not use the telephone to report a gas leak in the vicinity of the leak. 

4. Use only the power cord and batteries indicated in this manual. Do not   
 dispose of batteries in a fire. They may explode. Check with local codes for   
 possible special disposal instructions. 

5. This product is intended to be supplied by a Listed Power Unit (DC Output   
 20V, 11A minimum). 

 

CAUTION 
Always disconnect all telephone lines from the wall outlet before servicing or 
disassembling this equipment. 

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, 
TELECOMMUNICATION LINE CORD 

This Computer’s Optical Device is a Laser Class I Product 
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Preface

Instructions for Care and Operation 
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow 
these suggestions: 

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the   
 components could be damaged. 

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away  
 from any kind of heating ele¬ment. This is an electrical appliance. If water or  
 any other liquid gets into it, the computer could be badly damaged. 

3. Avoid interference. Keep the computer away from high capacity transformers,  
 electric motors, and other strong magnetic fields. These can hinder proper   
 performance and damage your data. 

4. Follow the proper working procedures for the computer. Shut the computer   
 down properly and don’t forget to save your work. Remember to periodically   
 save your data as data may be lost if the battery is depleted. 

• Do not expose it to excessive heat or direct sunlight. 

• Do not leave it in a place where foreign matter or moisture may affect the   
 system. 

• Don’t use or store the computer in a humid environment. 

• Do not place the computer on any surface that will block the vents. 

• Do not turn off the power until you properly shut down all programs. 

• Do not turn off any peripheral devices when the computer is on. 

• Do not disassemble the computer by yourself. 

• Perform routine maintenance on your computer. 

5. Take care when using peripheral devices.

• Use only approved brands of peripherals. 

• Unplug the power cord before attaching peripheral devices. 
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Power Safety 

The computer has specific power requirements: 

• Only use a power adapter approved for use with this computer. 

• Your AC/DC adapter may be designed for international travel but it still   
 requires a steady, uninterrupted power supply. If you are unsure of your   
 local power specifications, consult your service representative or local   
 power company. 

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The  
 third prong is an important safety feature; do not defeat its purpose. If you do  
 not have access to a compatible outlet, have a qualified electrician    
 install one. 

• When you want to unplug the power cord, be sure to disconnect it by the plug  
 head, not by its wire. 

• Make sure the socket and any extension cord(s) you use can support the total  
 current load of all the connected devices. 

• Before cleaning the computer, make sure it is disconnected from any external  
 power sup¬plies (i.e. AC/DC adapter or car adapter). 

• Do not plug in the power cord if you are wet. 

• Do not use the power cord if it is broken.  

• Do not place heavy objects on the power cord. 

Power Safety Warning

Before you undertake any upgrade procedures, make sure that you have turned off 
the power, and disconnected all peripherals and cables (including telephone lines). 
It is advisable to also remove you battery in order to prevent accidentally turning the 
machine on.
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Battery Precautions 

• Only use batteries designed for this computer. The wrong battery type may   
 explode, leak or damage the computer. 

• Do not continue to use a battery that has been dropped, or that appears   
 damaged (e.g. bent or twisted) in any way. Even if the computer continues to   
 work with a damaged battery in place, it may cause circuit damage, which   
 may possibly result in fire. 

• Recharge the batteries using the notebook’s system. Incorrect recharging may  
 make the battery explode. 

• Do not try to repair a battery pack. Refer any battery pack repair or    
 replacement to your service representative or qual¬ified service personnel. 

• Keep children away from, and promptly dispose of a damaged battery. Always  
 dispose of batteries carefully. Batteries may explode or leak if exposed to fire,  
 or improperly handled or discarded. 

• Keep the battery away from metal appliances. 

• Affix tape to the battery contacts before disposing of the battery. 

• Do not touch the battery contacts with your hands or metal objects. 

 

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is 
recyclable. At the end of its useful life, under various state and local laws, it may be 
illegal to dispose of this battery into the municipal waste stream. Check with your local 
solid waste officials for details in your areafor recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or 
equivalent type recommended by the manufacturer. Discard used battery according to 
the manufacturer’s instructions.
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Cleaning 

Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part 
of the computer.
 

Servicing
 
Do not attempt to service the computer yourself. Doing so may violate your warranty 
and expose you and the computer to electric shock. Refer all servicing to authorized 
service personnel. Unplug the computer from the power supply. Then refer servicing to 
qualified service personnel under any of the following conditions: 

• When the power cord or AC/DC adapter is damaged or frayed. 

• If the computer has been exposed to rain or other liquids. 

• If the computer does not work normally when you follow the operating instructions. 

• If the computer has been dropped or damaged (do not touch the poisonous   
 liquid if the LCD panel breaks). 

• If there is an unusual odor, heat or smoke coming from your computer. 

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, 
remember to replace the cover(s) and screw(s) before turning the computer on.
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Travel Considerations 

Packing 

As you get ready for your trip, run through this list to make sure the system is ready to go:  

1.  Check that the battery pack and any spares are fully charged. 

2.  Power off the computer and peripherals. 

3.  Close the display panel and make sure it’s latched. 

4.  Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 

5.  The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need   
 a second voltage adapter. However, check with your travel agent to see if you  
 need any socket adapters. 

6.  Put the notebook in its carrying bag and secure it with the bag’s straps. 

7.  If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack  
 them and those devices’ adapters and/or cables. 

8. Anticipate customs - Some jurisdictions may have import restrictions or   
 require proof of ownership for both hard¬ware and software. Make sure your  
 documents are prepared. 

Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a 
travel bag (or any other such container). Putting a notebook which is powered on 
in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your 
computer from overheating make sure nothing blocks the Vent/Fan Intakes while the 
computer is in use.
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On the Road 

In addition to the general safety and maintenance suggestions in this preface, and 
Chapter 8: Troubleshooting, keep these points in mind: 

Hand-carry the notebook - For security, don’t let it out of your sight. In some 
areas, computer theft is very common. Don’t check it with normal luggage. 
Baggage handlers may not be sufficiently careful. Avoid knock¬ing the computer 
against hard objects. 

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray 
machines can damage the com¬puter, hard disk, floppy disks, and other media. 
They may also destroy any stored data - Pass your computer and disks around 
the devices. Ask security officials to hand-inspect them (you may be asked to 
turn it on). Note: Some airports also scan luggage with these devices. 

Fly safely - Most airlines have regulations about the use of computers and other 
electronic devices in flight. These restrictions are for your safety, follow them. 
If you stow the notebook in an overhead compartment, make sure it’s secure. 
Contents may shift and/or fall out when the compartment is opened. 

Get power where you can - If an electrical outlet is available, use the AC/DC 
adapter and keep your battery(ies) charged. 

Keep it dry - If you move quickly from a cold to a warm location, water vapor can 
condense inside the computer. Wait a few minutes before turning it on so that 
any moisture can evaporate. 
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Developing Good Work Habits 

Developing good work habits is important if you need to work in front of the computer 
for long periods of time. Improper work habits can result in discomfort or serious injury 
from repetitive strain to your hands, wrists or other joints. The following are some tips 
to reduce the strain: 

• Adjust the height of the chair and/or desk so that the keyboard is at or   
 slightly below the level of your elbow. Keep your forearms, wrists, and hands  
 in a relaxed position. 

• Your knees should be slightly higher than your hips. Place your feet flat on the  
 floor or on a footrest if necessary. 

• Use a chair with a back and adjust it to support your lower back comfortably. 

• Sit straight so that your knees, hips and elbows form approximately    
 90-degree angles when you are working. 

• Take periodic breaks if you are using the computer for long periods of time. 

Remember to: 

•  Alter your posture frequently. 

• Stretch and exercise your body several times a day. 

• Take periodic breaks when you work at the computer for long   
 periods of time. Frequent and short breaks are better than fewer   
 and longer breaks. 

  

Lighting 

Proper lighting and comfortable display viewing angle can reduce eye strain and 
muscle fatigue in your neck and shoulders. 

• Position the display to avoid glare or reflections from overhead lighting or   
 outside sources of light. 

• Keep the display screen clean and set the brightness and contrast to levels   
 that allow you to see the screen clearly. 

• Position the display directly in front of you at a comfortable viewing distance. 

• Adjust the display-viewing angle to find the best position. 
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Chapter 1: Quick Start Guide Overview 

This Quick Start Guide is a brief introduction to the basic features of your computer, to 
navigating around the computer and to getting your system started. The remainder of 
the manual covers the following:

•  Chapter 2 A guide to using some of the main features of the computer 
e.g. the storage devices (hard disk, optical device, 4-in-1 card reader, 
ExpressCard/34/54), Auto Mail Program, TouchPad & Mouse, Audio & Printer.

• Chapter 3 The computer’s power saving options.

• Chapter 4 The installation of the drivers and utilities essential to the operation 
or improvement of some of the computer’s subsystems.

• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input 
Output System).

• Chapter 6 Instructions for upgrading your computer.

• Chapter 7 A quick guide to the computer’s Wireless LAN, Bluetooth, PC Camera 
and Port Replicator modules (some of which may be optional depending on your 
purchase configuration).

• Chapter 8 A troubleshooting guide.

• Appendix A Definitions of the interface, ports/jacks which allow your computer 
to communicate with external devices.

• Appendix B Information on the Intel Video driver controls.

• Appendix C The computer’s specification.
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Advanced Users 

If you are an advanced user you may skip over most of this Quick Start Guide. However 
you may find it useful to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on 
page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the User’s Manual. You may 
also find the notes marked with a (marker symbol) of interest to you.

Beginners and Not-So-Advanced Users 

If you are new to computers (or do not have an advanced knowledge of them) then 
the information contained in this Quick Start Guide should be enough to get you 
up and running. Eventually you should try to look through all the documentation 
(more detailed descriptions of the functions, setup and system controls are covered 
in the remainder of the User’s Manual), but do not worry if you do not understand 
every¬thing the first time. Keep this manual nearby and refer to it to learn as you go. 
You may find it useful to refer to the notes marked with a (marker symbol)as indicated 
in the margin. For a more detailed description of any of the interface ports and jacks 
see “Interface (Ports & Jacks)” on page A - 1.  

Warning Boxes 

No matter what your level please pay careful attention to the warning and safety 
information indicated by the (ringing-bell symbol). Also please note the safety and 
handling instructions as indicated in the Preface.  

Not Included 

Operating Systems (e.g. Windows XP etc.) and applications (e.g. word processing, 
spreadsheet and database pro¬grams) have their own manuals, so please consult the 
appropriate manuals. 
  

Drivers

If you are installing new system software, or are re-configuring your computer for a 
different system, you will need to install the drivers listed in “Drivers & Utilities” on 
page 4 - 1. Drivers are programs which act as an interface between the computer
and a hardware component e.g. a wireless network module. It is very important that 
you install the drivers in the order listed in Table 4 - 1, on page 4 - 6. You will be unable 
to use most advanced controls until the necessary drivers and utilities are properly 



Alienware Sentia 3450 Technical Reference

19

installed. If your system hasn’t been properly configured (your service representative 
may have already done that for you), refer to “What to Install” on page 4 - 1 for 
installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports 
& jacks) which allow your computer to communicate with external devices, connect to 
the internet etc.

System Software 

Your computer may already come with system software pre-installed. Where this is not 
the case, or where you are re-configuring your computer for a different system, you will 
find this manual refers to the Microsoft Windows XP (Home & Professional Editions) 
operating system.
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System Startup 

Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In

1. Remove all packing materials.

2. Place the computer on a stable surface.

3. Securely attach any peripherals you want to use with the notebook (e.g. 
keyboard and mouse) to their ports.

4. Attach the AC/DC adapter to the DC-In jack on the right of the computer, then 
plug the AC power cord into an

outlet, and connect the AC power cord to the AC/DC adapter (Note: If you have 
included the Port Replicator in

your purchase option see page 7 - 12).

5. Raise the lid/LCD to a comfortable viewing angle, and press the power button to 
turn the computer “on”.

6. Adjust the LCD panel to a comfortable viewing angle.

7. The LED Power & Communication indicators show the power and battery status 
of the computer, and give

notification of e-mail received. 

Shutdown

Please note that you should always shut your computer down by choosing the Shut 
Down/Turn Off Computer command from the Start menu in Windows. This will help 
prevent hard disk or system problems.
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System Map: Top View with LCD Panel Open 

 

Figure 1 - 2 - Top View with LCD Panel Open

1.  Optional Built-In PC Camera 

2. LCD 

3. Speakers 

4. LED Status Indicators 

5. Hot-Key Buttons  

6. Power Button

7. Keyboard

8. TouchPad and Buttons 

9. LED Power & Communication Indicators

10.  Built-In Microphone 
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Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually 
prohibited. Make sure the module(s) are OFF if you are using the computer aboard 
aircraft. Use the key combinations to toggle power to the WLAN/Bluetooth modules, 
and check the status indicator icon to see if the modules are powered on or not (see 
Table 1 - 2, on page 1- 6/Table 1 - 4, on page 1 -8).

LED Indicators

The two sets of LED indicators (LED Status Indicators and LED Power & Communication 
Indicators) on the computer display helpful information about the current status of the 
computer.

Icon Color Description

Blue
Number Lock Activated (to activate press Fn & 
NumLk)

Blue Caps Lock Activated

Blue Scroll Lock Activated (to activate press Fn & ScrLk)

Table 1 - 1 - LED Status Indicators
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Icon Color Description

Blue The Computer is On

Blinking Blue The Computer is in Stand by Mode

Amber
The AC/DC Adapter is Plugged In & the Computer is 
Powered Off

Amber
The AC/DC Adapter is Plugged In & the Battery is 
Charging

Blinking Amber The Battery Has Reached Critically Low Power Status

Blue The Battery is Fully Charged

Table 1 - 2 - LED Power & Communication Indicators

Icon Color Description

Blinking Blue New Mail Has Arrived

Blue Hard Disk Activity

Blue The WLAN Module is Powered On

Blue The Bluetooth Module is Powered On
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Hot-Key Buttons & Keyboard

These buttons give instant access to the default Internet browser and e-mail program, 
and to a user-defined application, with one quick button press. To use the “user 
defined application Hot-Key Button”, you must install the driver (see “Hot-Key 
(WinXP)” on page 4 -10).

Table 1 - 3  -Hot-Key Buttons

Hot-Key Function

Activate the user specified application e.g. Microsoft Word or Excel

Activate the Default E-Mail Program

Activate the Default Internet Browser

See “Application Hot-Key” on page 2 - 10 for configuration instructions.
Note: The hot-key buttons may appear slightly different from those illustrated in Table 
1 - 3, depending on your model/design.

The keyboard has an embedded numerical keypad for easy numeric data input, and 
features Function Keys to allow you to change operational features instantly (see 
Figure 1 - 3).

Figure 1 - 3 - Keyboard

Function Keys

Numeric
Keypad

NumLk &
ScrLk Keys

Fn Key
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Function Keys

The keyboard has an embedded numerical keypad for easy numeric data input, and 
features Function Keys to allow you to change operational features instantly (see
Figure 1 - 3).

Table 1 - 4 -Function Keys

Keys Description

Fn Function Key

Fn + 1 Touchpad Toggle

Fn + F3 Mute Toggle

Fn + F4 Sleep Toggle

Fn + F5 Decrease Audio Volume

Fn + F6 Increase Audio Volume

Fn + F7 Display Toggle

Fn + F8 Decrease LCD Brightness

Fn + F9 Increase LCD Brightness

Fn + F10 PC Camera Power Toggle

Fn + F11 Wireless Power Toggle

Fn + F12 Bluetooth Power Toggle

Fn + NumLk Number Lock Toggle

Fn + Scr Lk Scroll Lock Toggle
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Special Characters

Some software applications allow the number-keys to be used with Alt to produce 
special characters. These special characters can only be produced by using the 
numeric keypad. Regular number keys (in the upper row of the keyboard) will
not work. Make sure that NumLk is on.
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System Map: Front & Rear Views 
 

Figure 1 - 4 - Front & Rear Views 

Front & Rear Views 

1. LED Power & Communication Indicators

2. 4-in-1 Card Reader

3. External Monitor Port

4. S-Video-Out Jack

5. Security Lock Slot 

6. Battery
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4-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:
MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory 
Stick Pro) 

System Map: Left View 

Figure 1 - 4 Left View 

1. RJ-45 LAN Jack

2. Vent/Fan Intake

3. 2 * USB 2.0 Ports 

4. S/PDIF-Out Jack

5. Line-In Jack

6. Mini-IEEE 1394 Port

7. ExpressCard Slot

Figure 1 - 5 - Left View

1 2

3 4 5 6 7
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4-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:
MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory 
Stick Pro)

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) 
you may push the end of a straightened paper clip into the emergency eject hole. Do 
not use a sharpened pencil or similar object that may break and becomelodged in the 
hole.
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Media Warning

Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may 
cause the system to “crash”.

Changing DVD Regional Codes 

Go to the Control Panel and double-click System > Hardware (tab), click Device 
Manager, then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM 
device to bring up the Properties dialogue box, and select the DVD Region (tab) to 
bring up the control panel to allow you to adjust the regional code (see “DVD Regional 
Codes” on pages 2-5).

DVD region detection is device dependent, not OS-dependent. You can select your 
module’s region code 5 times. The fifth selection is permanent. This cannot be altered 
even if you change your operating system or you use the module in another computer.
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System Map: Bottom View 

Figure 1 - 7 - Bottom View

1. Vent/Fan Intake 

2. Battery 

3. Module Bay Cover 

4. Hard Disk Cover

CPU

The CPU is not a user serviceable part. Opening this compartment, or accessing the 
CPU in any way, may violate your warranty.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan 
Intake while the computer is in use.

Battery Information

Always completely discharge, then fully charge, a new battery before using it. 
Completely discharge and charge the battery at least once every 30 days or after about 
20 partial discharges. See “Battery Information” on page 3-9 for full instructions.

2

3

1

1

4
1

1
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Windows XP Start Menu & Control Panel 

Most of the control panels, utilities and programs within Windows XP are accessed 
from the Start menu. When you install programs and utilities they will be installed on 
your hard disk drive, and a shortcut will usually be placed in the Start menu and/or 
the desktop. You can customize the look of the Start menu by right-clicking the Start 
menu and selecting Properties from the menu. 
 

In many instances throughout this manual you will see an instruction to open the 
Control Panel. The Control Panel is accessed from the Start menu. The Control Panel 
allows you to configure the settings for most of the key features in Windows (e.g. 
power, video, network, audio etc.). Windows XP provides basic control panels for many 
of the features, however many new control panels are added (or existing ones are 
enhanced) when you install the drivers listed in Table 4 - 1, on page 4 - 6. To see all 
controls it may be necessary to toggle off Category View.

Figure 1-8
Start Menu & Control Panel
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Video Features 

Your computer has built-in Intel (Intel 945GM) video. You can switch display devices, 
and configure display options, from the Display Properties control panel in Windows 
as long as the appropriate video driver is installed. To access Display Properties in 
Windows:

1. Click Start, point to Settings and click Control Panel (or just click Control   
 Panel). 

2. Double-click Display (icon) - In the Appearances and Themes category. 

3. Click Settings (tab) in the Display Properties dialog box. 

4. Move the slider to the preferred setting in Screen area/resolution (1)

5.  Click the arrow and scroll to the preferred setting in Colors/Color Quality (2)

6. You can also access Display Properties by right-clicking the desktop and   
 scrolling down and clicking Properties. Click Settings (tab) and adjust as 

 above.

7. Open the Display Properties control panel, and click Advanced (button) (3)   
 (Figure 1 - 9 on page 1 - 15) to bring up the Advanced properties tabs.

8. Click the Intel(R) Graphics Media Accelerator Driver for Mobile tab, and click  
 Graphics Properties (button) to make any video adjustments you require.

Display Devices & Options 

Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat 
Panel Display or TV as your display device. A VGA monitor/Flat Panel Display connects 
to the external monitor port, a TV to the S-Video-Out jack. The following display modes 
are available (see “Intel Video Driver Controls” on page B- 1 for details).
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Figure 1 -9 - Display Properties Desktop

Display Mode Description

Single One of the connected displays is used as the display device

Twin Mode This mode will drive multiple displays with the same content and 
resolutions, color quality etc.

Intel(R) Dual 
Display Clone
Mode

Both connected displays output the same view and may be 
configured independently

Extended 
Desktop Mode

Both connected displays are treated as separate devices, and 
act as a virtual desktop

Table 1-5 Display Options

*Intel Display Note: Note that the notebook is the default Primary display device and 
may not be changed.

1
2

3
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Power Management Features 

The Power Options control panel icon in Windows (see page 1 - 13) allows you to 
configure power managementfeatures for your computer. You may conserve power  
through individual components such as the monitor or hard disk (by means of Power 
Schemes), or you may use either Stand by or Hibernate mode to conserve power
throughout the system (enable Hibernate support from the control panel as pictured in 
Figure 1 - 10). Pay attention to the instructions on battery care in “Battery Information” 
on page 3 - 9.

 
Figure 1 - 10 - Power Options 

The computer’s power button, sleep button (Fn + F4 key combination), and lid (closing 
the lid) may be set to send the computer in to either Stand by or Hibernate mode. 

Power Saving and Performance 

Power Schemes may have an affect on your computer performance (see “Power 
Schemes” on page 3 - 4). 
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Chapter 2: Features & Components

Overview

Read this chapter to learn more about the following main features and components of 
the computer: 

• Hard Disk Drive 

• Optical Device 

• 4-in-1 Card Reader 

• Express Card Slot  

• Auto Mail Checker

• Application Hot-Key 

• TouchPad and Buttons/Mouse

• Audio Features

• Adding a Printer 

Hard Disk Drive 

The hard disk drive is used to store your data in the computer. The hard disk can be 
taken out to accommodate other 2.5” serial (SATA) hard disk drives with a height of 
9.5 mm. The hard disk is accessible from the bottom of your computer as seen below. 

Figure 2 - 1 Hard Disk Location 
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Optical Device 

There is a bay for a 5.25” optical (CD/DVD) device (12.7mm height). The actual device
will depend on the module you purchased. The optical device is usually labeled “Drive 
D:” and may be used as a boot device if properly set in the BIOS.

Loading Discs 

To insert a CD/DVD, press the open button 
1. and carefully place a CD/DVD onto the disc tray with label-side facing up   
 (use just enough force for the disc to click onto the tray’s spindle).   
 Gently push the CD/DVD tray in until its lock “clicks” and you are ready to   
 start. The busy indicator 

2. will light up while data is being accessed, or while an audio/video CD, or   
 DVD, is playing. If power is unexpectedly interrupt¬ed, insert an object such  
 as a straightened paper clip into the emergency eject hole 

3. to open the tray. 

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control 
within Windows. Click the Volume icon on the taskbar to check the setting.

Peripherals must be connected before you turn on the system.

Figure 2 - 2 Optical Device

2
1

3
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Handling CDs or DVDs 

Proper handling of your CDs/DVDs will prevent them from being damaged. Please 
follow the advice below to make sure that the data stored on your CDs/DVDs can be 
accessed. 

Note the following: 

• Hold the CD or DVD by the edges; do not touch the surface of the disc. 

• Use a clean, soft, dry cloth to remove dust or fingerprints. 

• Do not write on the surface with a pen. 

• Do not attach paper or other materials to the surface of the disc. 

• Do not store or place the CD or DVD in high-temperature areas. 

• Do not use benzene, thinner, or other cleaners to clean the CD or DVD. 

• Do not bend the CD or DVD. 

• Do not drop or subject the CD or DVD to shock. 

CD Emergency Eject

If you need to manually eject a CD (e.g. due to an unexpected power interruption) you 
may push the end of a straightened paper clip into the emergency eject hole. However, 
please do NOT use a sharpened pencil or similar object that may break and become 
lodged in the hole.

Disk Eject Warning

Don’t try to remove a CD/DVD while the system is accessing it. This may cause the 
system to “crash.”
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DVD Regional Codes 

To change the DVD regional codes see “Changing DVD Regional Codes” on page 1 - 10. 

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South 
Korea, The Philippines, Indonesia, 
Hong Kong 

4 South & Central America, Mexico, 
Australia, New Zealand 

5 N. Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1 DVD Regional Coding

Figure 2 - 3 DVD Regions
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4-in-1 Card Reader 

The card reader allows you to use some of the latest digital storage cards. Push the 
card into the slot and it will appear as a removable device. 

• MMC (MultiMedia Card) 

• SD (Secure Digital) 

• MS (Memory Stick) 

• MS (Memory Stick Pro) 

*Note: The PC adapters are usually supplied with these cards. 

Figure 2 - 4 Left View 

1. Card Reader 

ExpressCard Slot

The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Express
Card/54 and 34mm for the ExpressCard/34. Make sure you install the Express-
Card driver.

1
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Inserting and Removing ExpressCards

• Align the ExpressCard with the slot and push it in until it locks into place.

• To remove an ExpressCard, simply press the card to eject it. 

Figure 2 - 5 ExpressCard Slot 
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Auto Mail Checker

After you have installed the driver for the Auto Mail Checker program you may then 
configure it to give you notification when you receive new mail. You must be online to 
receive this notification (note that this program only supports the POP3 protocol), and 
your default mail program does not need to be open.

The Auto Mail Checker appears as an icon in the taskbar (if you do not see the
icon in the taskbar go to Start > Programs/All Programs > Auto Mail Checker >
Auto Mail Checker). Right clicking on the icon will bring up the following options
menu. If you have not input your mail account data, then you will be prompted to do
so.

Select Open to bring up the control panel for the program.

You may then configure the options for your mailserver, name, password, program and 
method(s) of notification.

Figure 2 - 7 Auto Mail Checker Account Setup and Options

Note: Check with your Internet Service Provider, network administrator or Mail Service 
provider for details on what to put on these pages.
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Application Hot-Key

The hot-key buttons give instant access to the default Internet browser and e-mail
program, and to a user-defined application, with one quick button press. To configure
a program to open when the application hot-key is pressed (Windows Media
Player is the default program), follow the instructions below.

1. Right click the Hot-Key driver icon in the taskbar.
2. Select Setup from the menu, scroll to Application 1 and press Enter.

3. An Open dialog box will appear on the screen.

4. Browse to the directory where the desired application.exe (see the sidebar)
     program exists.
5. Double-Click on the program file or choose Open.

Figure 2 - 8 Hot-Key Configuration Screens
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TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. The central button may be configured to
function as you require.

Configuring the TouchPad and Buttons

Once you have installed the TouchPad driver you can configure the functions by
double-clicking the TouchPad driver icon in the taskbar, or by going to the
Mouse control panel in Windows (Start menu and point to Settings and click Control
Panel, then double-click the Mouse icon). In Windows XP the Mouse control
panel is in the Printers and Other Hardware Category. The TouchPad may be
toggled on/off by means of the Fn + F1 key combination.Configuration (Advanced 
Menu)” on page 5 - 9). For further information, please refer to the manual of the device 
you wish to connect. 

Figure 2 - 9 Mouse Properties
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Audio Features

You can configure the audio options on your computer from the Sounds and Audio
Devices Windows control panel, or from the Realtek HD Audio Manager
icon in the taskbar/control panel (this will bring up the Realtek Audio Configuration
menus). The volume may also be adjusted by means of the Fn + F5/F6 key 
combination.  

Figure 2 - 10 Realtek Audio Configuration Menus

Sound Volume Adjust8 Channel Sound Support

If you wish to configure your system for 8 channel sound support, then the following
ports should be used as outputs. Double-click the appropriate icon (e.g. ) to bring
up the “Connected device:” dialog box to configure the output port.

 • Side Speaker Out - Connect to S/PDIF Out
 • Center/Subwoofer Speaker Out - Connect to Microphone In
 • Front Speaker Out - Connect to Speaker/Headphone Out
 • Rear Speaker Out - Connect to Line In
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Adding a Printer

The most commonly used peripheral is a printer. The following conventions will
help you to add a printer, however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer

Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:

 1. Set up the printer according to its instructions (unpacking, paper tray,         
      toner/ink cartridge etc.).
 2. Turn ON the computer.
 3. Turn ON the printer.
 4. Connect the printer’s USB cable to one of the USB ports on the computer.
 5. Windows will identify the printer and either load one of its own drivers or   
     ask you to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar.
Note: If you have included the Port Replicator in your purchase option, then a parallel
port will be available, otherwise you will need to purchase a parallel to USB
converter.
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Chapter 3: Power Management 

Overview 

To conserve power, especially when using the battery, your computer uses the ACPI 
power management system. Power management conserves power by controlling 
in¬dividual components of the computer (the monitor and hard disk drive) or the 
whole system. 

This chapter covers: 
• The Power Sources 

• Turning on the Computer 

• Power Schemes 

• System Power Options 

• Configuring the Power Button 

• Battery Information 

Advanced Configuration and Power Interface 

The ACPI interface provides the computer with enhanced power saving techniques 
and gives the operating system (OS) direct control over the power and thermal states 
of devices and processors. For example, it enables the OS to set devices into low-
power states based on user settings and information from applications. ACPI is fully 
supported in Windows XP.

OS Note

Power management functions will vary slightly depending on your operating system. 
For more information it is best to refer to the user’s manual of your operating system.

(Note: All pictures used on the following pages are from the Windows XP OS)

Power Button as Stand By or Hibernate Button

If you are using a fully ACPI-compliant OS, (such as Windows XP) you can use the OS’s 
“Power Options” control panel to set the power button to send the system into Stand 
by or Hibernate mode (see your OS’s documentation, or “Configuring in the Power 
Button” on page 3-8 for details)
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The Power Sources 

The computer can be powered by either an AC/DC adapter or a battery pack. 

AC/DC Adapter 

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/ DC 
adapter will damage the computer and its components. 

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer. 

2. Plug the AC power cord into an outlet, and then connect the AC power cord   
 to the AC/DC adapter. 

3. Raise the lid/LCD to a comfortable viewing angle. 

4. Press the power button to turn “On”. 

Battery 

The battery allows you to use your computer while you are on the road or when an 
electrical outlet is unavailable. Battery life varies depending on the applications 
and the configuration you’re using. To increase battery life, let the battery discharge 
completely before recharging. We recommend that you do not remove the battery. 
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Turning on the Computer 

Now you are ready to begin using your computer. To turn it on simply press the power 
button on the front panel. 

When the computer is on, you can use the power button as a Stand by/Hibernate/ 
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and 
holding the power button for longer than this will shut the computer down). 
Use Power Options in the Windows control panel to configure this feature. 

Forced Off

If the system “hangs,” and the Ctrl+Alt+Del key combination doesn’t work, press the 
power button for 4 seconds, or longer, to force the system to turn itself off.

Shutdown

Note that you should always shut your computer down by choosing the Shut Down/
Turn Off Computer command from the Start menu in Windows. This will help prevent 
hard disk system problems.

Resuming Operation 

Press a key on the keyboard to have the system resume form Monitor or Hard Disk 
Stand By.



Alienware Sentia 3450 Technical Reference

51

Power Schemes 

You can set your computer to conserve power through individual components by 
means of Power Schemes. You can also adjust the settings for each scheme to set the 
monitor to turn off after a specified time, and the computer’s hard disk motor to turn 
off if the hard disk drive has not been accessed for a specified period of time (if the 
system reads or writes data, the hard disk motor will be turned back on). The schemes 
may also be set to set a specified time for the system to enter Stand by or Hibernate 
modes.

Figure 3 - 1 Power Schemes 

Each Windows Power Scheme will also adjust the processor performance of your 
machine in order to save power. This is worth bearing in mind if you are experienc¬ing 
any reduced performance (especially under DC/battery power). 

Choose the Home/Office Desk scheme for maximum performance when the com¬puter 
is powered from an AC power source. Choose the Max Battery scheme (bear in mind 
that this scheme may slow down the overall performance of the computer in order 
to save power) for maximum power saving when the computer is battery (DC power) 
powered. 

Windows will use Portable/Laptop as the default scheme. 
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System Power Options
 
You can use the system power options to stop the computer’s operation and restart 
where you left off. This system features Stand by and Hibernate sleep mode levels 
(Hibernate mode will need to be enabled by clicking the option in the Hibernate tab in 
the Power Options control panel - Figure 3 - 2 on page 3 - 7). 

Hibernate Mode vs. Shutdown 

Hibernate mode and Shutdown are the same in that the system is off and you need to 
press the power button to turn it on. Their main difference is: 
When you come back from hibernation, you can return to where you last left off (what 
was on your desktop) without reopening the application(s) and file(s) you last used. 
You can use either method depending on your needs. 
Stand by Mode vs. Hibernate Mode 
If you want to stay away from your work for just a while, you can put the system on 
Stand by instead of in hibernation. It takes a longer time to wake up the system from 
Hibernate mode than from Stand by mode. 
 
 

Stand by 

Stand by saves the least amount of power, but takes the shortest time to return to full 
operation. During Stand by the hard disk is turned off, and the CPU is made to idle at 
its slowest speed. All open applications are retained in memory. When you are not 
using your computer for a certain length of time, which you specify in the operating 
system, it will enter Stand by mode to save power. 

Hibernate 

Hibernate uses no power and saves all of your information on a part of the HDD 
be¬fore it turns the system off. Although it saves the most power it takes the longest 
time to return to full operation. You can set your computer to automatically enter 
Hiber¬nate mode when the battery power is almost depleted. You will need to enable 
Hi¬bernate mode from the Hibernate tab in the Power Options control panel. The 
system will resume from Hibernate mode by pressing the power button. 
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Figure 3 - 2 Enable Hibernation 

System Resume

The system can resume from Stand by mode by:

• Pressing the power button

• Pressing the Fn + F4 key combination

• An alarm resume that is enabled and expires

• An incoming call received on the modem (if enabled)

• Network card activity (if enabled)
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Configuring the Power Button 

The power button may be set to send the computer in to either Stand by or Hibernate 
mode. In Stand by mode, the LED will blink green. In Hibernate mode the LED will 
be off. If you are in a power saving mode set to save power through individual 
components (e.g. hard disk, monitor), the LED will remain green.

Power Button Lid Sleep/Resume (Sleep) Button

Sleep Button

You may also configure the Sleep/Resume key combination (Fn+F4) from the menu 
illustration in figure 3-3. In Windows this is referred to as the sleep button.
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Battery Information 

Please follow these simple guidelines to get the best use out of your battery. 

New Battery 

Always completely discharge, then fully charge, a new battery.

Battery Life 

Your computer’s battery life is dependent upon many factors, including the pro¬grams 
you are running, and peripheral devices attached. Power Options (you may set low 
battery Alarms and actions, and check the Power Meter from the Power Options 
control panel), and settings in the OS will help prolong the battery life if configured 
appropriately. 
 
Battery life may be shortened through improper maintenance. To optimize the life and 

improve its performance, fully discharge and recharge the battery at least once every 
30 days. 

We recommend that you do not remove the battery yourself. If you do need to re¬move 
the battery for any reason see “Removing the Battery” on page 6 - 3. 

Figure 3 - 4 Power Options (Alarm & Power Meter) 
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Recharging the Battery with the AC/DC Adapter 

The battery pack automatically recharges when the AC/DC adapter is attached and 
plugged into an electrical outlet. If the computer is powered on, and in use, it will 
take several hours to fully recharge the battery. When the computer is turned off but 
plugged into an electrical outlet, battery charge time is less.  
 

Proper handling of the Battery Pack 

• DO NOT disassemble the battery pack under any circumstances 

• DO NOT expose the battery to fire or high temperatures, it may explode 

• DO NOT connect the metal terminals (+, -) to each other 

Low Battery Warning

When the battery is low, immediately connect the AC/DC adapter to the computer or 
save your work, otherwise, the unsaved data will be lost when the power is depleted.

Conserving Battery Power

To conserve battery power:
Lower the brightness level of the LCD display. The system will decrease LCD brightness 
slightly to save power when it is not powered by the AC/DC adapter.

Close modem or communication applications when they are not being used.

Remove any unused PC Cards from the computer (PC Cards quickly use up battery 
power even if the system enters sleep mode).

Disconnect any unnecessary external devices.



Alienware Sentia 3450 Technical Reference

57

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after 
being dropped), or any unusual smells emanating from the notebook battery, shut 
your computer down immediately and contact your service center. If the battery has 
been dropped we do not recommend using it any further, as even if the computer 
continues to work with a damaged battery in place, it may cause circuit damage, which 
may possibly result in fire. It is recommended that you replace your computer battery 
every two years.

Battery FAQ 

How do I completely discharge the battery? 
Use the computer with battery power until it shuts down due to a low battery. Don’t 
turn off the computer by yourself even when you see a message that indicates the 
battery is critically low, just let the computer use up all of the battery power and shut 
down on its own. Disable the Power Options functions in the Control Panel, espe¬cially 
any Alarms (unclick the tickboxes - see 3 - 9) and Schemes (change all the settings 
to Never - see page 3 - 4). As the battery nears the end of its life save and close any 
critical files. 

How do I fully charge the battery? 
When charging the battery, don’t stop until the LED charging indicator light changes 
from orange to green. 

How do I maintain the battery? 
Completely discharge and charge the battery at least once every 30 days or after about 
20 partial discharges. 
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Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utili¬ties essential to the operation 
or improvement of some of the computer’s subsystems. The system takes ad¬vantage 
of some newer hardware components for which the latest versions of most available 
operating systems haven’t built in drivers and utilities. Thus, some of the system 
components won’t be auto-config-ured with an appropriate driver or utility during 
oper¬ating system installation. Instead, you need to manually install some system-
required drivers and utilities.The following operating system is covered. 

• Windows XP Professional and Home Editions (with Service Pack 2) 

What to Install 

The Device Drivers & Utilities + User’s Manual CDROM contains the drivers and utilities 
necessary for the proper operation of the computer. The drivers for all the modules 
(WLAN, Bluetooth, PC Camera and TV Tuner) are on the separate CD-ROMs supplied. 
Table 4 - 1 on page 4 - 6 lists what you need to install manually according to your 
choice of the operating system, and it is very important that the drivers are installed in 
the order indicated. 

Module Driver Installation 

The procedures for installing drivers for the Wireless LAN, Bluetooth, TV Tuner, PC 
Camera and RAID modules are provided in “Modules”. Make sure that the drivers are 
installed in the order in¬dicated in Table 4 - 1. 
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Navigate (Browse...) to D:

You will notice that many of the instructions for driver installation require you to 
“Navigate (Browse) to D:”. We assume that you will install all drivers and utilities from 
the built-in CD device and its assigned to “Drive D:”. In addition, all file extensions 
can be seen.

In this case “D:” is the drive specified for your CD device. Not all computers are setup 
the same way, and some computers have the CD listed under a different drive letter 
- e.g. if you have two hard drives (or hard disk partitions) one may be designated as 
“Drive C:” and the other as “Drive D:”. In this case the CD device may be designated as 
“Drive E:” - Please make sure you are actually navigating to the correct drive letter for 
the CD device.

When you click the Browse (button) after clicking Run in the Start menu you will see 
the “Look in:” dialog box at the top of the Browse window. Click the scroll button to 
navigate to My Computer to display the devices and drive letters.
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Service Packs 

Check the warnings on the following pages regarding installation of the appropriate 
Service Pack for your Windows OS. If you are unsure of the Service Pack currently 
installed see below. Make sure you have in¬stalled the appropriate Service Pack 
before installing all the drivers. 

Service Pack Installed

To see which Service Pack is currently installed on your computer go to the General tab 
of the System control panel. Right-click the My Computer icon on the desktop or in the 
Start menu and select Properties. The service Pack currently installed on your system 
will be listed under the “System” heading. (If no Service Pack information is listed, 
then no Service Pack is installed.)

Windows XP Service Pack 2

Make sure you install Windows XP Service Pack 2 (or make a Windows XP version 
which includes Service Pack 2) before installing any drivers. Service Pack 2 includes 
support for USB 2.0

If you have upgraded the system by installing Service Pack 2 (i.e. your Windows XP 
version does not include Service Pack 2) then follow these instructions.

1.  Click Start (menu), point to Settings and click Control Panel (or click Control  
 Panel).

2.  Double-Click System (icon). System (icon) is in Performance and    
 Maintenance (category).

3.  Click the Hardware (tab) > Device Manager (button).

4.  Click “+” next to Other Devices (if its sub-items are not shown).

5.  Right-click Universal Serial Bus (USB) Controller and select Uninstall > OK (if  
 you don’t see the item then there is no need to take any further action). 

6.  Restart the computer and it will find the USB 2.0 controller.
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Authorized Driver Message 

If you receive a message telling you that the driver you are installing is not authorized 
(Digital Signature Not Found), just click Yes or Continue Anyway to ignore the message 
and continue the installation procedure. 

You will receive this message in cases where the driv¬er has been released after the 
version of Windows you are currently using. All the drivers provided will have already 
received certification for Windows. 

Version Conflict Message 

During driver installation if you encounter any “file version conflict” message, please 
click Yes to choose to keep the existing (newer) version. 
Updating/Reinstalling Individual Drivers 

If you wish to update/reinstall individual drivers it may be necessary to uninstall the 
original driver.To do this go to the Control Panel in the Windows OS and double-click 
the Add/Remove Programs item. If you see the individual driver listed (if not see 
below), un-install it, following the on screen prompts (it may be necessary to restart 
the computer). Go to the appropri¬ate section of the manual to complete the update/
reinstall procedure for the driver in question. 

If the driver is not listed in the Add/Remove Programs item: 
1. Click Start (menu), point to Settings and click Control Panel (or click Start >   
 Control Panel). 

2. Double-click System (icon); System (icon) is in Performance and    
 Maintenance (category). 

3. Click Hardware (tab) > Device Manager (button). 

4. Double-click the device you wish to update/reinstall the driver for (you may  
 need to click “+”). 

5. Look for the Update Driver button (check the Driver tab) and follow the on   
 screen prompts. 
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Driver Installation 

Insert the Device Drivers & Utilities + User’s Manual CD-ROM and the Notebook Driver 
Installation appli¬cation will run automatically. 

1. Check the driver installation order from Table 4 - 1 (the drivers    
 must be installed in this order) which is the same as that listed in the driver  
 installation screen menu. 

2. Double-click to select the name of the driver you wish to install. 

3. Follow the instructions as listed in this chapter. 

4. Make a note of the drivers you have installed. 

5. If a restart is required after installing a driver, you will usually need to click   
 the “Yes/Finish” button when prompted to restart the computer. 

6. To get back to the Notebook Driver Installation screen click Start (menu) >   
 Run... and navigate (Browse..) to D:\setup.exe and click OK.

Driver Installation Screen

• Double-click the My Computer icon, and then

• Double-click the CD icon.
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Windows XP (SP2)

Driver Page Driver Page

Chipset Page 4-7 AutoMail (Manual 
Driver Installation 

Only)

Page 4-11

Video Page 4-7 Bluetooth Page 7-2

Audio Page 4-7 PC Camera Page 7-5

Modem/LAN Page 4-8 WLAN Module Page 7-11

TouchPad Page 4-9 Wireless LAN Page 7-12

ExpressCard/
Card Reader

Page 4-9 Port Replicator 
Serial Port

Page 7-13

Hot-Key Buttons Page 4-9 (LAN) Port Page 7-14

Table 4 - 1 - Driver Installation 

Manual Driver Installation 

If you wish to install the drivers manually, click the Exit button to quit the Notebook 
Driver Installation appli¬cation, and then follow the manual installation procedure for 
each driver. The manual installation procedure be¬gins with instructions on how to 
browse to the executable file; “Click Start (menu) > Run..”. 
 
 

Windows XP Driver Installation Procedure 

This section covers driver and utility installation in¬structions for Windows XP Home & 
Professional. In¬sert the Device Drivers & Utilities + User’s Manual CD-ROM and click 
the appropriate driver name from the NoteBook Driver Installation menu and follow 
the instructions to install the driver, or Click Start and navigate (Browse..) to follow the 
manual setup in¬structions. 

To get back to the Notebook Driver Installation screen click Start (menu) > Run... and 
navigate (Browse..) to D:\setup.exe and click OK. OR Double-click the My Computer 
icon, and then dou-ble-click the CD icon. 
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New Hardware Found 

If you see the message “New Hardware Found” (Found New Hardware Wizard) during 
the installa¬tion procedure (other than when outlined in the driver install procedure), 
click Cancel to close the window, and follow the installation procedure. 

Chipset 
1. Double-click Chipset. 

2. Give the driver time to install, and the com¬puter will restart to complete   
 the installation. 

OR 
1. Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\00CHIPSET\ 
 setup.exe and click OK. 

2. Click Next > Next > Next > Yes. 

3. Click Finish to restart the computer. 
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Video  

1. Double-click VGA. 

2. Give the driver time to install, and the computer will restart to complete the  
 installation.

OR
1. Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\01VGA\  
 setup.exe and click OK. 

2. Click Next (click Continue Anyway if asked if you want to continue at any   
 time). 

3.  Click Finish to restart the computer. 

 

Audio 

1.  Double-click Audio. 

2.  The installation will be complete when the AVRack icon appears on the   
 desktop. 

OR 
1.  Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\02AUDIO\  
 setup.exe and click OK. 

2.  Click Next. 

3. Click Finish to restart the computer.
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Modem 

1. Double-click Modem. 

2. Give the driver time to install, and a Found New Hardware bubble will   
 appear in the bot¬tom right of the screen to inform you when the driver has  
 been successfully installed. 

OR
1.  Click Start (menu) > Run... and navigate  (Browse..) to D:\Drivers\03MODEM\ 
 Setup.exe and click OK. 

2. Click Next. 

3. The modem is now ready for configuration. 

4. Click Install > Finish. 

LAN

1.  Double-click Lan. 

2. Give the driver time to install, and a Local Area Connection bubble will   
 appear in the bottom right of the screen. 

OR
1. Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\04LAN\  
 SetupYukonWin.exe and click OK. 

2. Click OK > OK. 

3.  Click the button to accept the license and click Next. 

4. The network settings can now be configured. 

Modem Country Selection

Be sure to check if the modem country selection is appropriate for you (Control Panel > 
Phone and Modem Options).
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Hot-Key Buttons 

1.  Double-click Hot-key. 

2.  Give the driver time to install, and the computer will restart to complete the  
 installation. 

OR 
1. Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\Hot-Key\  
 Setup.exe and click OK. 

2. Click Next. 

3. Click Finish to restart your computer. 

TouchPad 

1. Double-click Touchpad. 

2. Give the driver time to install, and then restart the computer to complete the 
installation (the TouchPad driver icon  will appear in the task-bar). 

OR 
1.  Click Start (menu) > Run... and navigate (Browse...) to D:\Drivers\   
 06TOUCHPAD\setup.exe and click OK. 

2. Click Next > Next (click Continue Anyway if asked if you want to continue at   
 any time). 

3. Click Finish to restart your computer. 

4. You may then configure your TouchPad as outlined in “TouchPad and   
 Buttons/Mouse” on page 2 - 8. 
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AutoMail Checker

1. Double-click AUTOMAIL. 
OR 

Click Start (menu) > Run... and navigate 

(Browse..) to D:\Drivers\09AUTOMAIL\SETUP.EXE and click OK. 
2. To continue click Next > Next > Finish. 
3. Run the program from the Auto Mail Checker in the Start menu (Start > 
Programs/All Programs > Auto Mail Checker). 
4. Click the X icon in the taskbar to input the e-mail account details. 

5. For further details see “AutoMailChecker” on page 2-8.

Module Drivers 

See the pages indicated for the driver installation pro¬cedures for any modules 
included in your purchase op¬tion. 

PC Camera 

See the install procedure in “PC Camera Module” on page 7 - 2. 
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Wireless LAN 

See the appropriate install procedure for your WLAN module in either “Intel WLAN 
Driver Installation” on page 7 - 9, or “MSI 6833B WLAN Driver Installation” on page 7-10. 

Bluetooth 

See the install procedure in “Bluetooth Driver Installation” on page 7 - 12. 

TV Tuner 

See the install procedure for your TV Tuner module in 
“Installing the AverTV Utility Software” on page 7-15. 

RAID 

See the setup procedure for your RAID module in “RAID Setup” on page 7 - 17. 
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Chapter 5: BIOS Utilities Overview 

This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test) 

Configuration: The Setup utility If your computer has never been set up, or you are 
making important changes to the system (e.g. hard disk setup), then you should 
review this chapter first and note the original settings found in Setup. Even if you are 
a beginner, keep a record of the set¬tings you find and any changes you make. This 
information could be useful if your system ever needs servicing. 

There is one general rule: Don’t make any changes unless you are sure of what you 
are doing. Many of the settings are required by the system, and changing them could 
cause it to become unstable or worse. If you have any doubts, consult your service 
representative. 

BIOS Settings Warning

Incorrect settings can cause your system to malfunction. To correct mistakes, return to 
Setup and restore the Setup Defaults with <F9>.
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The Power-On Self Test (POST) 

Each time you turn on the computer, the system takes a few seconds to conduct a 
POST, including a quick test of the on-board RAM (memory). 

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a 
problem that prevents the system from booting, it will display a system summary and 
prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load the 
operating system. Once that starts, you can’t get into Setup without rebooting. 

POST Screen

1.  BIOS Information

2. CPU Type

3. Memory Status

4.  Enter Setup prompt appears only during POST

Note: The POST screen as pictured is for guideline purposes only.
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Failing the POST 

Errors can be detected during the POST. There are two categories, “fatal” and 
“non¬fatal”. 
 

Fatal Errors 
 
These stop the boot process and usually indicate there is something seriously wrong 
with your system. Take the computer to your service representative or authorized 
service center as soon as possible. 

Non-Fatal Errors 

This kind of error still allows you to boot. You will get a message identifying the 
problem (make a note of this message!) followed by the prompt: 

 • Press <F1> to resume 

 • <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without the correct 
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an 
error message after you change the setting, or if the “cure” seems even worse, call for 
help.
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The Setup Program 

The Phoenix Setup program tells the system how to configure itself and manage ba¬sic 
features and subsystems (e.g. port configuration). 

Entering Setup 

To enter Setup, turn on the computer and press F2 during the POST. The prompt 
(Press F2 to Enter Setup) seen in Figure 5 - 1 on page 5 - 2 is usually present for a few 
seconds after you turn on the system. If you get a “Keyboard Error”, (usually because 
you pressed F2 too quickly) just press F2 again. 

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then 
hold down F2 when prompted. The Setup main menu will appear. 
 
 

Setup Screens 

The following pages contain additional advice on portions of the Setup. 
Along the top of the screen is a menu bar with five (5) menu headings. When you 
select a heading, a new screen appears. Scroll through the features listed on each 
screen to make changes to Setup. 

Instructions on how to navigate each screen are in the box along the bottom of the 
screen. If these tools are confusing, press F1 to call up a General Help screen, and 
then use the arrow keys to scroll up or down the page. 

The Item Specific Help on the right side of each screen explains the highlighted item 
and has useful messages about its options. 

If you see an arrow next to an item, press Enter to go to a sub-menu on that sub¬ject. 
The sub-menu screen that appears has a similar layout, but the Enter key may execute 
a command. 

Setup Menus

The Setup menus shown in this section are for reference only. Your computer’s menus 
will indicate the configuration appropriate for your model and options.
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Main Menu

Figure 5 - 2  Main Menu

System Time & Date (Main Menu) 

The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you 
can change the date and time settings in your operating system, you will also change 
these settings. Some applications may also alter data files to reflect these changes. 
 
 

Primary Master/SATA Port 3/4 (Main Menu) 

Pressing Enter here opens the sub-menu to show the configuration of hard disks and 
CD/DVD device(s) on the computer’s SATA Channels. Use the Auto (Type:) set¬ting to 
have the items configured automatically for you. 

System/Extended Memory: (Main Menu) 

This item contains information on the system memory, and is not user configurable. 
The system will auto detect the amount of memory installed. 

The Main menu also contains information on your video card and video BIOS ver¬sion.
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Advanced Menu

Figure 5 - 3 Advanced Menu 

Advanced Chipset Control (Advanced Menu) 

Pressing Enter here will access the sub-menu which allows you to disable the audio 
and modem devices if required; and you can also Enable/Disable the RAID func¬tion 
from this menu. 
 
 

I/O Device Configuration (Advanced Menu) 

The sub-menus under this item allow you to enable/disable the Serial port A (Serial 
Mouse), and FIR (Infrared) transceiver. 

Reset Configuration Data (Advanced Menu) 

This item is set to No as default. You can change the setting to Yes if you have 
in¬stalled a new add-on which has reconfigured the system, resulting in such a 
serious system conflict that the operating system is unable to boot. 

Power On Boot Beep (Advanced Menu) 

Use this menu to enable/disable the single beep sound at the end of the POST. This 
item is “Disabled” by default. 
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Security Menu

Figure 5 - 4 Security Menu 

Set Supervisor Password (Security Menu) 

You can set a password for access to the Setup utility. This will not affect access to the 
computer OS, (only the Setup utility) unless you choose to set a Password on Boot 
(see over). 
 
 

Password on boot: (Security Menu) 

Specify whether or not a password should be entered to boot the computer. If 
“Enabled” is selected, only users who enter a correct password can boot the system 
(see the warning in the sidebar). The default setting is “Disabled”. 

Note: To clear existing passwords press Enter and type the existing password, then 
press Enter for the new password (without typing any password entry) and Enter again 
to confirm the password clearance. 

Security Menu

The changes you make here affect the access to the Setup utility itsel, and also access 
to your machine as it boots up after you turn it on. These settings do not affect your 
machine or network passwords which will be set in your software OS.
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Password Warning

If you set a boot password (Password on boot is “Enabled”). NEVER forget your 
password.

The consequences of this could be serious. If you cannot remember your boot 
password you must contact your vendor and you may lose all of the information on 
your hard disk.
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Boot Menu

Figure 5 - 5 Boot Menu

When you turn the computer on it will look for an operating system (e.g. WindowsXP) 
from the devices listed in this menu, and in this priority order. If it cannot find the 
operating system on that device, it will try to load it from the next device in the order 
specified in the Boot priority order. Item specific help on the right is available to help 
you move devices up and down the order.
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Exit Menu

Figure 5 - 6 Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any changes 
you have made to the Setup. You can also choose to restore the original Setup defaults 
that will return the Setup to its original state, and erase any previous changes you 
have made in a previous session.
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Chapter 6: Upgrading The Computer Overview 

This chapter contains information on upgrading the computer. Follow the steps 
outlined to make the desired upgrades. If you have any trouble or problems you can 
contact your service representative for further help. Before you begin you will need: 

 • A small crosshead or Phillips screwdriver 

 • A small regular slotted (flathead) screwdriver 

 • An antistatic wrist strap 

Before working with the internal components you will need to wear an antistatic wrist 
strap to ground yourself because static electricity may damage the components. 
The chapter includes: 

 • Removing the Battery 

 • Upgrading the Hard Disk Drive(s) 

 • Upgrading the System Memory (RAM) 

 • Upgrading the Optical (CD/DVD) Device(s) 

 • Removing the Video Card(s) 

Please make sure that you review each procedure before you perform it. 
 
 

 Warranty Warning

Please check with your service representative before undertaking any upgrade 
procedures to find out if this will VOID your warranty.

 

Power Safety Warning

Before you undertake any upgrade procedures, make sure that you have turned off 
the power, and disconnected all peripherals and cables (including telephone lines). 
It is advisable to also remove your battery in order to prevent accidentally turning the 
machineon.
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When Not to Upgrade 

These procedures involve opening the system’s case, adding and sometimes replacing 
parts.You should not perform any of these upgrades if: 

 • Your system is still under warranty or a service contract 

 • You don’t have all the necessary equipment 

 • You’re not in the correct environment 

 • You doubt your abilities 

Under any of these conditions, contact your service representative to purchase or 
replace the component(s). 
 

Removal Warning

When removing any cover(s) and screw(s) for the purposesof device upgrade, 
remember to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor 

If you want to upgrade your computer by replacing the existing processor with a 
faster/new one you will need to contact your customer service representative. We 
recommend that you do not do this yourself, since if it is done incorrectly you may 
damage the processor or mainboard. 
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Removing the Battery 

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is 
best to remove the battery. 

1. Turn the computer off, and turn it over.

2. Slide the latch in the direction of the arrow, and hold it in place.

3. Slide the battery in the direction of the arrow .

4. Lift the battery up and out in the direction of the arrow .

5. Insert the battery by pushing it straight down into the battery bay (it will only 

     fit one way, don’t force it).

6. Make sure the battery is sitting flat in the slot, and then slide the battery in     

     the direction of the arrow until the lock clicks into place.

1

1

2

3

4
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Upgrading the Hard Disk Drive(s) 

The hard disk drive(s) can be taken out to accommodate other 2.5” serial (SATA) hard 
disk drives with a height of 9.5mm (h). Follow your operating system’s installation 
instructions, and install all necessary drivers and utilities , when setting up a new hard 
disk. 

1. Turn off the computer, and turn it over and remove the battery. 

2. Locate the hard disk bay cover and remove screws  

3. Pull the tab to slide the hard disk and case assembly in the direction of arrow .

4. Lift the hard disk and case assembly out of the bay in the direction of arrow .

5. Remove screws & to release the hard disk from the case , and

     reverse the process to install any new hard disk.

1 2

3

4

75

8

6
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Upgrading the System Memory (RAM) 

The computer has two memory sockets for 200 pin Small Outline Dual In-line 
(SO¬DIMM) DDR type memory modules. The total mem¬ory size is automatically 
detected by the POST routine once you turn on your com¬puter. 

1. Turn off the computer, and turn it over and remove the battery. 

2. Locate the component bay cover and remove screws 

1

2

5

4

3

3. Remove the bay cover

6
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4. Gently pull the two release latches on the sides of the memory socket in the

       direction indicated by the arrows

7

8

4. The RAM module will pop-up, and you can remove it

9

6. Pull the latches to release the second module if necessary.

7. Insert a new module holding it at about a 30° angle and fit the connectors  

     firmly into the memory slot.

8. The module’s pin alignment will allow it to only fit one way. Make sure the  

     module is seated as far into the slot as it will go. DO NOT FORCE the module; 

     it should fit without much pressure.

9. Press the module in and down towards the mainboard until the slot levers 

     click into place to secure the module.

10. Replace the memory socket cover and the screw.

11. Restart the computer to allow the BIOS to register the new memory 

     configuration as it starts up.
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Upgrading the Optical (CD/DVD) Device(s) 

1. Turn off the computer, and turn it over and remove the battery.

2. Locate the module bay cover and remove screws - and remove the bay

cover.

3. Use a screwdriver to carefully push out the optical device at point .

4. Reverse the process to install the new device.

1

2

5

4

3

6
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Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a faster/
new one you will need to contact your customer service representative. We recommend
that you do not do this yourself, since if it is done incorrectly you may damage the 
processor or mainboard.

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the 
CPU in any way, may violate your warranty.

Unauthorized tampering with the HDD may also violate your warranty.
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Chapter 7: Modules Overview 

This chapter contains the information on the various modules (some of which are 
optional) which may come with your computer, depending on the configuration 
purchased. If you are unsure please contact your service representative. 

The chapter includes information on the following: 

• PC Camera Module 

• Bluetooth Module 

• PCIe WLAN Module

• Port Replicator

PC Camera Module 

If your purchase includes the optional PC Camera you will need to install the device 
driver for it as indicated on the following pages. 
 

PC Camera Driver Installation 

1. Insert the PC Camera CD-ROM into the CD/DVD Drive. 

2. The program will run automatically. 

3. Click Next (click Continue Anyway if asked if you want to continue at any time). 

4. Click Finish > OK to restart the computer. 

5. Use the Ap-Key button to turn the PC Camera module on (the LED will be   
 green). 

6. Run the emAMCAP application software from the USB2.0 1.3M PC CAM   
 item in the Start > Programs/All Programs menu (give the compu¬ter time to  
 find the hardware). 
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PC Camera Audio Setup 

If you wish to capture video & audio with your camera, it is necessary to setup the 
audio recording options in Windows. 

1. Go to the Start menu and point to Settings (or click Control Panel) and click  
 Control Panel, then double-click the Sounds & Audio Devices icon (Sounds,  
 Speech, and Audio Devices in Category View). 

2. Click Advanced in Device volume (Volume tab). 

3. Click Options and scroll down and click Properties. 

4. Select Realtek AC97 Audio from the Mixer Device menu. 

5. Click Recording (button). 

6. Click Microphone (check box) if it is not checked, and then click OK. 

7. Make sure the Select (check box) in the Recording Control panel, under the  
 Microphone section, is checked (boost the volume as high as it will go). 

8. Close the window, and then click OK. 

x
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Latest PC Camera Driver Information

Check the PC Camera CD, and any accompanying insert pages, for the latest updated 
information on the PC Camera driver, which may override the information provided.
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BisonCap

BisonCap is a video viewer useful for general purpose video viewing and testing,
and can capture video files to .avi format.

1. Run the BisonCap program from the Start > Programs/All Programs > Bison-

Cam menu (it is recommended that you set the capture file before the capture

process - see Set Capture File below).

2. Go to the Capture menu heading and select Start Capture.

3. On the first run of the program (if you have not set the captured file) you will 
be asked to choose a file name and size (see the sidebar - Pre-Allocating File

Space) for the captured file. Click Start Capture again.

4. Click OK to start capturing the video, and press Esc to stop the capture.

5. If you wish to, you may go to the File menu and select Save Captured Video

As..., choose a file name and location, and then click Open (you can view the 
file using the Windows Media Player).

Set Capture File 

In the EMAMCAP program you will only be asked to set the capture file name on 
the first run of the program. When you run the program the next time the file will 
automatically be overwritten with the newly captured file. To avoid overwriting files 
you can go to the Set Capture File.. option in the File menu, and set the file name and 
location before capture. Set the name and location then click Open (you can choose 
Cancel to ignore the file size if prompted). 
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Eliminating Screen Flicker 

If you find that the video screen in the EMAMCAP program is flickering, you can try to 
adjust the setting in the Lighting Selection options. 

1.  Run the EMAMCAP program. 

2.  Go to Options and scroll down to select “Video Capture Filter...”. 

3.  Click Video Image (tab). 

4.  Select Florescent 50Hz, Florescent 60Hz or Incandescent in the Light   
 dropbox. 

Figure 7 - 3 Video Image 
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PCIe WLAN Module 

If you have included an Intel PRO/Wireless 3945ABG (802.11a/b/g) PCIe WLAN
module in your purchase option, you will have the appropriate software CD provided
for your module.

Before installing the Intel 3945ABG (802.11a/b/g) PCIe WLAN driver, make sure
that the Wireless LAN module is on (the LED will be blue). Use the Fn + F11
key combination to toggle power to the Wireless LAN module. Make sure you install 
the drivers in the order indicated.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usally 
prohibited. Make sure the module(s) are OFF if you are using the computer aboard 
aircraft.

Intel WLAN Driver Installation 

1. Make sure the module is powered on, and then insert the Intel PROSet/   
 Wireless CD-ROM into the CD/DVD drive. 

2. Click Install Software (button). 

3. Click the button to accept the license and click Next > Next > OK. 

4. Click OK to complete the installation. 

5. You can configure the settings by going to the Intel (R) PROSet Wireless   
 control panel (Start > Programs/All Programs > Intel PROSet Wireless), or by   
 double-clicking the taskbar icon 

Figure 7 - 4 Intel PROSet/ Wireless
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Port Replicator

If you have included the Port Replicator in your purchase option, the device will allow
you to easily attach the notebook to standard, non-portable devices e.g. a printer
or monitor. Note the sidebar warning on the power supply.

You will be provided with a CD including drivers for the serial (COM) port, and for
the network (LAN) jack. See “Port Replicator Setup Instructions:” for configuration 
information.

 1. 4 * USB Ports
 2. RJ-45 LAN Jack
 3. Parallel (printer) Port
 4. Serial Port
 5. External Monitor Port
 

 
 6. Port Replicator DC-In
 7. Port Replicator Power Cable (to computer’s DC-In)
 8. External Monitor Cable (to computer’s External Monitor Port)

Port ReplicatorAC/DC Adapter

You will be provided with a 90W AC/DC adapter if you purchase the port replicator 
option. If you are using the computer with the Port Replicator, then you must use the 
90W AC/DC adapter to power the port replicator and computer (DO NOT USE the
computer’s 65W AC/ DC adapter to power the Port Replicator).

1 2 3 4 5

7

6

8
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Port Replicator Setup Instructions:

 1. Turn the computer OFF.
 2. Attach the Port Replicator’s external monitor cable to the external monitor   
     port on the rear of the computer.
 3. Attach the Port Replicator’s power cable to the DC-In jack on the right of the
     computer.
 4. Attach the Port Replicator’s (90W) AC/DC adapter unit to the DC-In jack on   
     the left side of the Port Replicator (DO NOT USE THE COMPUTER’S POWER
     UPPLY UNIT TO POWER THE PORT REPLICATOR.
 5. Turn ON the computer.
 6. Install the serial port driver (see below).
 7. Install the LAN driver.
 8. Plug in any devices you require into the appropriate Port Replicator port/  
      jack (note certain devices may require their own drivers, and/or 
      the computer to restart).

For a more detailed description of any of the interface ports and jacks, see “Interface
(Ports & Jacks)”.

Port Replicator Serial (COM) Port Driver (WinXP)

 1. Insert the provided Port Replicator CD into the computer’s CD/DVD drive.
 2. Click Start (menu) > Run... and navigate (Browse...) to
      D:\PL-2303 Driver Installer\PL-2303 Driver Installer.exe and click OK.
 3. Click Next > Finish (see over for LAN driver installation instructions).

Port Replicator Network (LAN) Driver (WinXP)

 1. Attach the Port Replicator as per the instructions in “Port Replicator”.
 2. Insert the provided Port Replicator CD into the computer’s CD/DVD drive.
 3. If you can see the My Computer icon on the desktop (if you cannot see the
      My Computer icon go to step 4) click on it once to select it, then rightclick
      it to make the sub-menu appear and scroll down to Properties and
      click on it (go to step 5).
 4. If you cannot see the My Computer icon Start (menu), then point to (but
      don’t click it, just highlight it) My Computer. Right-click it to make the
      sub-menu appear and scroll down to Properties and click on it (go to step 5).
 5. Click Hardware (tab), and then click Device Manager (button).
 6. Click “+” next to Other devices (if its sub-menu items are not shown).
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 7. Double-click AX88772 and click Driver (tab).
 8. Click Update Driver (button).
 9. Select “No, not this time” and then click Next.
 10. When the Hardware Update Wizard appears, click “Install from a list or
        specific location (Advanced)” and then click Next.
 11. Select “Search for the best driver in these driver in these locations.” and
        select ONLY “include this location in the search:”.
 12. Navigate (Browse...) to D:\LAN and click OK > Next.
 13. Click Finish and close the open windows.
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Bluetooth Module 

Before installing the Bluetooth driver, make sure that the optional Bluetooth mod¬ule 
is on (the LED will be green). Use the Ap-key to toggle power to the Bluetooth module. 
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 6. 
Bluetooth Driver Installation 

1. Make sure the module is powered on, and then insert the Bluetooth CDROM  
 into the CD/DVD drive. 

2. The program will run automatically. 

3. Choose the language you prefer, and click OK. 

4. Click Next. 

5. Click the button to accept the license agreement, and then click Next. 

6. Click Next > Next > Install. 

7. Click Finish > Yes to restart the computer. 

8. The IVT Corporation BlueSoleil - Main Window screen appears on restart. 

9. You can confi gure the settings at any time by going to the IVT Corporation   
 BlueSoleil - Main Window control panel (Start > Programs/All Programs > IVT  
 BlueSoleil), or by clicking the taskbar icon
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Chapter 8: Troubleshooting Overview 

Should you have any problems with your computer, before consulting your service 
representative, you may want to try to solve the problem yourself. This chapter lists 
some common problems and their possible solutions. This can’t anticipate every 
problem, but you should check here before you panic. If you don’t find the answer in 
these pages, make sure you have followed the instructions carefully and observed the 
safety precautions in the preface. If all else fails, talk to your service representative. 
You should also make a record of what happened and what remedies you tried. 
Of course, if something goes wrong, it will happen at the most inconvenient time 
possible, so you should preview this section just in case. If, after you’ve tried 
everything, and the system still won’t cooperate, try turning it off for a few minutes 
and then rebooting. You will lose any unsaved data, but it may start working again. 
Then call your service representative. 
 
  

Basic Hints and Tips 

Many of the following may seem obvious but they are often the solution to a problem 
when your computer ap¬pears not to be working. 

 

• Power - Is the computer actually plugged into a working electrical outlet?   
 If plugged into a power strip, make sure it is actually working. Check the LED   
 Power Indicators (see “LED Indicators” on page 1 - 6) to see the computer’s   
 power status. 

• Connections - Check all the cables to make sure that there are no loose   
 connections anywhere. 

• Power Savings - Make sure that the system is not in Hibernate or Stand by   
 mode by pressing the keys con¬figured in your Power Management/Power   
 Options (see “Configuring the Power Button” on page 3 - 8), the Fn + F4 key   
 combination, or power button to wake-up the system. 

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9  
 keys to adjust the bright¬ness (see Table 1 - 4, on page 1 - 8). 

• Display Choice - Press Fn + F7 to make sure the system is not set to “external   
 only” display (see Table 1 4, on page 1 - 8). 

• Boot Drive - Make sure there are no optical media and/or USB storage devices  
 in any connected drive when you start up your machine (this is a common   
 cause of the message “Invalid system disk - Replace the disk, and then press  
 any key” / “Remove disks or other media. Press any key to restart”). 
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Backup and General Maintenance 
 

• Always backup your important data, and keep copies of your OS and programs  
 safe, but close to hand. Don’t forget to note the serial numbers if you are   
 storing them out of their original cases, e.g. in a CD wal¬let. 

• Run maintenance programs on your hard disk and OS as often as you can.   
 You may schedule these pro¬grams to run at times when you are not   
 using your computer. You can use those that are provided free with your OS,   
 or buy the more powerful dedicated programs to do so. 

• Write down your passwords and keep them safe (away from your computer).   
 This is especially important if you choose to use a Boot password for the SCU  
 (see “Security Menu” on page 5 - 10). 

• Keep copies of vital settings files such as network, dialup settings, mail   
 settings etc. (even if just brief notes). 

 

Viruses 

• Install an Anti-Virus program and keep the definitions file (the file which tells  
 your program which viruses to look for) up to date. New computer viruses   
 are discovered daily, and some of them may seriously harm your computer   
 and cause you to lose data. Anti-Virus programs are commercially available   
 and the definitions file updates are usually downloadable directly from the   
 internet. 

• Be careful when opening e-mail from sources you don’t know. Viruses are   
 often triggered from within e-mail attachments so take care when opening any  
 attached file. You can configure most Anti-Virus pro¬grams to check all e-mail  
 attachments. Note: You should also beware of files from people you know as   
 the virus may have infected an address book and been automatically   
 forwarded without the person’s knowl¬edge. 

• Keep a “Bootable CD-ROM” (this disk provides basic information which   
 allows you to startup your com¬puter) handy. You may refer to your OS’s   
 documentation for instructions on how to make one, and many Anti-Virus   
 programs will also provide such a disk (or at least instructions on    
 how to make one). 
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Upgrading and Adding New Hardware/Software 

• Do not be tempted to make changes to your Windows Registry unless you are  
 very sure of what you are doing, otherwise you will risk severely damaging   
 your system. 

• Don’t open your computer or undertake any repair or upgrade work if you are   
 not comfortable with what you are doing. 

• Read the documentation. We can assume, since you are reading this   
 that you are looking at the computer’s manual, but what about any    
 new peripheral devices you have just purchased? Many problems are   
 caused by the installation of new hardware and/or software. Always refer to   
 the documentation of any new hardware and/or software, and pay particular   
 attention to files entitled “READ ME” or “READ ME FIRST”. 

• When installing a new device always make sure the device is powered on, and  
 in many cases you will need to restart the computer. Always check that all the  
 cables are correctly connected. 

• Make sure you have installed the drivers for any new hardware you have   
 installed (latest driver files are usually available to download from vendor’s   
 websites). 

• Thoroughly check any recent changes you made to your system as these   
 changes may affect one or more system components, or software programs.   
 If possible, go back and undo the change you just made and see if    
 the problem still occurs. 

• Don’t over complicate things. The less you have to deal with then the easier   
 the source of the problem may be found; Example - if your computer has many  
 devices plugged into its ports, and a number of programs running, then it will  
 be difficult to determine the cause of a problem. Try disconnecting all of   
 the devices and restarting the computer with all the peripheral    
 devices unplugged. A process of elimination (adding and removing    
 devices and restarting where necessary) will often find the source of   
 a problem, although this may be time consuming. 
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Problems & Possible Solutions

Problem Possible Cause - Solution

You turned the 
power on but it 
doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is 
present and seated properly (the design of the battery only allows it to go in one way). Make 
sure there’s nothing interfering with the battery contacts.

The Battery LED 
power indicator , is 
blinking orange.

Low Battery. Plugin the AC power source. If the computer doesn’t start up immediately, turn 
it off then on again.

You are losing 
battery power too 
quickly.

The system is using too much power. If your OS has a Power Options scheme (see 
“PowerSchemes” on page 3- 4) check its settings. You may also be using a PC Card device 
that is drawing a lot of power.

Actual battery 
operating time 
is shorter than 
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is 
fully discharged and recharge it completely beforere using (see “Battery Information”on 
page 3-9).
 
Power Options have been disabled. Go to the Control Panel inWindows and re-enable 
the options. 

Aperipheral device or PC Card is consuming alot of power. Turn off the unused device to 
save power.

Problem Possible Cause - Solution

The computer feels 
too hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If 
this doesn’t cool it down, put the system into Hibernate mode or turn if off for an hour. Make 
sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1-9). Make 
sure you’re using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a travel bag (or 
any such container). Putting a notebook which is powered on in a travel bag may cause the 
vents/fan intake to be blocked.

Nothing appears 
on screen

The system is in a power saving mode. Toggle the sleep/resume key combination, Fn+F4 
(see “Sleep Button” on page 3-8). The screen controls need to be adjusted. Toggle the 
screen control key combination, Fn+F8/F9 (see Table 1-4, on page 1-8). If you’re connected 
to an external monitor, make sure it’s plugged in and turned on. You should also check the 
monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key combination, Fn+F7 
(see Table 1-4, on page 1-8). If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears 
on the external 
monitor I have 
plugged in and 
powered on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. 
See “NVIDIA Video Driver Controls” on Page 8-1 for instructions on installing and configuring 
the video driver.
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Problem Possible Cause - Solution

You forget the boot 
password.

If  you forget the password, you may have to discharge the battery of the CMOS. Contact your 
service representative for help. 

Password Warning 
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious.If 
you cannot remember your boot password you must contact your vendor and you may lose all of the information on 
your hard disk.

The sound cannot 
be heard or the 
volume is 
verylow. 

The volume might be set too low. Check the volume control in the Volume Control Panel in 
the Windows taskbar, or use the key combination Fn+ F5 and F6 (see “Audio Features” on 
page 2-11) to adjust. 

The compact disc 
cannot be read. 

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc 
tray will not open 
when there 
is a disc in the tray. 

The compact disc is not correctly placed in the tray. Gently try to remove the discusing the 
eject hole (see  “LoadingDiscs” on page 2-3). 

The DVD regional 
codes can no 
longer be changed. 

The code has been changed the maximum 5 times. (See “DVDRegional Codes” on page 2-5).

Problem Possible Cause - Solution

The TouchPad 
doesn’t work.

The Touch pad has been disabled. Press the Touchpad toggle Fn+F1 key combination (make 
sure you have installed the Touchpad driver.

The system freezes 
or the screen goes 
dark.

The system’s power saving features have timed-out. Use the AC/DCadapter, press a key on 
the keyboard, or press the sleep Fn+F4 key combination, or press the power button if no 
LEDs are lit.

The system never 
goes into a power 
saving mode.

Power Options features are not enabled. Go to the Windows Power Options menu and enable 
the features you prefer (see “System Power Options”on page 3- 6). Make sure you have 
enabled Hibernate mode from the control panel.

The Wireless 
LAN/Bluetooth/PC 
Camera modules 
cannot be 
detected.

The modules are off. Check the appropriate LED indicator to see if the modules are on or off 
(see “LED Indicators”on page 1- 6). If the LED indicator is off, then press the appropriate 
AP-Key button/function key combination in order to enable the modules (see Table1- 3, on 
page 1-7/ Table 1-4,on page 1-8).

The Wireless 
LAN/Bluetooth/PC 
Camera modules 
cannot be 
configured.

The modules are off. Check the appropriate LED indicator to see if the modules are on or 
off (see “LED Indicators”onpage 1- 6). If the LED indicator is off, then press the appropriate 
AP-Key button/function key combination in order to enable the modules (see Table1- 3, on 
page 1-7/Table 1-4,on page 1-8).

The PC Camera 
software displays a 
black screen when 
the EMAMCAP 
software is run.

The software is using the incorrect device. If you have both the optional PC Camera and 
TV Tuner modules present, make sure you install the TV Tuner driver and application first. 
After installing the PC Camera driver you will need to select which device to use with the 
EMAMCAP program. Go to the Devices menu in the EMAMCAP program and select the USB 
2.01.3M PC CAM device (see “PCCamera & TV Tuner”on page 7- 2).
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Appendix A: Interface (Ports & Jacks) Overview 

The following chapter will give a quick description of the ports & jacks which allow 
your computer to commu¬nicate with external devices, connect to the internet etc. 
 
 

Ports and Jacks

Icon Description

Built in Microphone

The built-in microphone allows you to record on your computer .

Card Reader

The card reader allows you touse the following digital storage cards: 

MMC (MultiMedia Card) 
SD(SecureDigital) 
MS(MemoryStick) 

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA)
Port

This port allows you to connect an external monitor, or Flat Panel Display, to 
get dual video or simultaneous display on the LCD and external monitor/
FPD.

Headphone-Out Jack
Headphones or speakers may be connected through this jack. Note: Set 
your system’s volume to a reduced level before connecting to this jack.

USB 2.0/1.1 Ports

These USB2.0 compatible ports (USB2.0 is fully USB1.1 compliant) are 
for low-speed peripherals such as keyboards, mice or scanners, and for 
high-speed peripherals such as external HDDs, digital video cameras or 
high-speed scanners etc. Devices can be plugged into the computer, and 
unplugged from the computer, without the need to turn the system off (if 
the power rating of your USB device is 500mA or above, make sure you use 
the power supply which comes with the device). 
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Icon Description

RJ-11 Phone Jack

This port connects to the built-in modem You may plug the telephone line 
directly into this RJ-11telephone connection. 

Note: Broadband (e.g. ADSL) modem susually connect to the LAN port.

RJ-45 LAN Jack

This port supports LAN (Network) functions. 

Note: Broadband (e.g. ADSL)modems usually connect to the LAN port.

S/PDIF-Out Jack

This S/PDIF (Sony/PhilipsDigital Interface Format) Out Port allows you to 
connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” 
or ‘dts’ surround sound. 

Security Lock Slot

To prevent possible theft, a Kensington-type lock can be attached to this 
slot. Locks can be purchased at any computer store. 

Serial Port

Connect a serial type mouse to this port. 

S-Video-In Jack

The S-Video-In jack allows video input to the computer if you have included 
the optional Mini-PCI TV Tuner in your purchase.

7-Pin S-Video-Out Jack

Connect your television to your computer and view DVDs,VCDs or anything 
else your computer can display. You will need a 7-pin S-Video plug to 4-pin 
S-Video jack adapter and S-Video cable to make the connection (see “7-Pin 

S-Video-OutJack”on page 1-9). 

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set 
your system’s volume a reduced level before connecting to this jack.
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Icon Description

Infrared (FIR) Transceiver

The FIR (far infrared) transceiver on the right of the computer allows 
the computer to communicate with similarly equipped devices (see 
“Configuring the Infrared Settings for “FIR”on page 2- 12).

Line-In Jack

The Line-In jack allows you to play audio sources through the computer’s 
speakers. Note that audio input through Line-in will default to the mute 
setting. To set up your audio sources to play through the Line-in jack go to 
the Sounds and Audio Devices Windows control panel and make sure the 
Mute box is not ticked. 

Microphone-In Jack

Plug an external microphone in to this jack to record on your computer. 

Mini-IEEE 1394a Ports

This allows high-speed connection to various peripheral devices, e.g. 
external disk drives And digital cameras. The Mini-IEEE 1394a ports only 
support SELF POWERED IEEE 1394 devices.



Alienware Sentia 3450 Technical Reference

107

Appendix B: Intel Video Driver Controls 

The basic settings for configuring the LCD are outlined in “Video Features”. 

Intel Video Driver Installation
Make sure you install the drivers in the order indicated. 

 1. Double-click VGA. 
OR 
 Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\Video\setup.  
 exe and click OK. 

 2. Click Next (click Continue Anyway if asked if you want to continue at any time). 

 3. Click Finish to restart the computer. 

Dynamic Video Memory Technology

Intel® DVMT 3.0 automatically and dynamically allocates as much (up to 128MB)
system memory (RAM) as needed to the video system (the video driver must be
installed. DVMT returns whatever memory is no longer needed to
the operating system.
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Intel Graphics Properties

More advanced video configuration options are provided by the Intel(R) Graphics
Media Accelerator Driver for Mobile control panel.

 1. Open Display Properties > Settings > Advanced.
 2. Click the Intel(R)... tab and click Graphics Properties (button).
 3. You can also access Graphics Properties from the Windows Intel(R) GMA   
     Driver for Mobile control panel, or from the taskbar icon         .

Taskbar Icon

You can also access the controller properties from the taskbar. Click on the icon to 
bring up the menu and scroll to Graphics Properties.

If you cannot see the tray icon go to the Intel(R) Graphics Media Accelerator Driver for 
Mobile tab and click the “Show Tray Icon” tickbox. Alternatively rightclick the desktop 
and select Graphics Options > Tray Icon > Enable.
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You may make changes to the devices, color, schemes, Hot Keys etc. by clicking
the appropriate menu item or button. Click Information (button) to obtain useful 
information about the graphics properties of the computer, and see the Support tab in
Information to get weblinks to the latest information on the Intel Website.

Help Menus

Right-click on many of the items in the tabs to bring up the “What’s This?” button.
Click the “What’s This?” button to bring up the help menu.

Multiple Display

At least one other display must be attached in order to view Multiple Display options.

Figure B - 3 Intel Graphics Media Accelerator Driver
for mobile (Control Panel Tabs)
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Display Devices

Besides the built-in LCD, you can also use an external monitor/flat panel display or
TV as your display device. The following are the display options:

 1. The built-in LCD.
 2. An external monitor connected to the external monitor port.
 3. A flat panel display connected to the external monitor port.
 4. A TV connected to the S-Video-Out jack. 

Function Key Combination

You can use the Fn + F7 key combination to toggle through the display options:

 • Notebook Only
 • External Display Only
 • Notebook + External Display

Make sure you give the displays enough time to refresh.

Switching Modes When Using the Power DVD Application

Switch display modes before playing any DVD in the Power DVD Application it is not be
possible to switch display modes while a DVD is playing (you will be required to stop 
the DVD playing, switch display modes, then start the DVD playing again).

Attaching Other Displays

If you prefer to use a monitor or flat panel display, connect it to the external monitor
port at the rear of the computer.

1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out
    jack), and turn it on.
2. Go to the Graphics Properties control panel (see “Intel Graphics Properties”
    on page B - 3) and click Display Devices.
3. Click to choose the display option from the Multiple Display menu.
4. Click Apply (and OK to confirm the settings change) and OK (button).
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Intel Display Note

Note that the notebook is the default Primary display device and may not be changed.

Display Modes

Single Display
Only one of your attached displays is used.

Twin
This mode will drive multiple displays with the same content and resolutions, color
quality etc. (does not support a TV as a display device). See “Twin Mode Support”
on page B - 8 for more information.

Intel(R) Dual Display Clone
This mode will drive multiple displays with the same content. Each device may be
configured independently for different resolutions, refresh rates, color quality etc.
Use this feature to display the screen through a projector for a presentation.

Extended Desktop
This mode allows a desktop to span multiple displays and acts as a large workspace.
This creates a lot more screen area for display. Use the Display Properties control
panel to drag the monitors to match the physical arrangement you wish to use, or you
may also use the Extended Desktop Settings control panel tab in Graphics Properties
to configure the relative size and position.
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To Enable Intel(R) Dual Display Clone Mode OR Twin Mode

1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out
     jack), and turn it on.
2. Go to the Graphics Properties control panel (see “Intel Graphics Properties”) and        
     click Display Devices.
3. Click to choose Intel(R) Dual Display Clone or Twin.
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Clone Mode

Twin Mode
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To Enable Extended Desktop Mode:

1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out
    jack), and turn it on.
2. Go to the Graphics Properties control panel (see “Intel Graphics Properties”) and         
     click Display Devices.
3. Click to choose Extended Desktop.
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Click the appropriate monitor icon and drag it to match the physical arrangement you 
wish to use (e.g. the secondary display may be extended left/right/above/below the 
primary display). Click Display Settings to make any adjustments required.

You can also enable the Extended Desktop mode from the Display Properties control
panel.
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To Enable Extended Desktop (Windows Display Properties) 

1. Attach your external monitor to the external monitor port and turn it on. 
2. Click Start, point to Settings (or click Control Panel) and click Control Panel (if you   
 are in Category View choose Appearance and Themes). 
3. Double-click Display (icon). 
4. Click Settings (tab). 
5. Click the monitor icon (e.g.   ), and make sure you have checked “Extend my   
 Windows desktop onto this monitor.” and click Apply. 

Click the appropriate monitor icon (e.g.   ) to be able to select the option to extend 
the desktop on to it. 

In this example the Primary monitor  is on the left, the secondary display  is on 
the right. 

Figure B-10 Display Properties (Extended Desktop)

Display Settings Extended Desktop

To get a full range of options from the Device Settings menu click the Detect Displays 
button. Click to select the TV icon, then click the Device Settings button.

3

3

1 3
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Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the timeof going to press. 
Certain items (particularly processor types/speeds and CD/DVD Device types) maybe 
changed or updated due to the manufacturer’s release schedule. Check with your 
service center for details. 

Feature Specifications

Processor Types
Intel® Core™ Duo Processor
(478-pin) Micro-FC-PGA Package
T2300/ T2400/ T2500/ T2600/ T2700

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 667MHz FSB
1.66/ 1.83/ 2.0/ 2.16/ 2.33 GHz

Intel® Core™ Solo Processor
(478-pin) Micro-FC-PGA Package
T1300/ T1400

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 667MHz FSB
1.66/ 1.83 GHz

Intel® Celeron® M Processor
(478-pin) Micro-FCPGA Package
410/ 420/ 430

65nm (65 Nanometer) Process Technology
1MB On-die L2 Cache & 533MHz FSB
1.46/ 1.60/ 1.73 GHz

Core Logic Intel 945GM + ICH7-M

LCD 14.0” WXGA (1280*768) Flat Panel TFT

Security Security (Kensington® Type) Lock Slot BIOS Password

Memory Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 533 / 667 MHz
128-bit Wide DDRII (DDR2) Data Channel
Memory Expandable up to 2GB (256/ 512/ 1024 MB DDRII Modules (Note: Do Not Use Other Module Types)

BIOS One 4Mb Flash ROM  Phoenix BIOS

Feature Specifications

Video Card Options
Intel 945GM Integration
Supports Dynamic Video Memory Technology DVMT 3.0 
- Up to 128MB of Video Memory (dynamically
allocated from system memory where needed)
Supports Analog Monitor Pixel Resolution up to 1600 * 
1200 at 85Hz
Supports DirectX 9

Storage Options One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Optional” for
drive options) Easy Changeable 2.5” 9.5 mm (h) HDD with SATA (Serial) Interface 

Card Reader Built-In 4-in-1 Card Reader (SD/MMC/MS/MS Pro)

Audio
 Integrated AZALIA Compliant Interface (HDA)
3D Stereo Enhanced Sound System
Sound-Blaster PRO™ Compatible
2 * Built-In Speakers
Built-In Microphone

Keyboard & 
Pointing Device

Winkey Keyboard Built-InTouchPad (Scroll Functionality Included)
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Feature Specifications

PCMCIA OneType II PCMCIA 3.3V/5V Socket

Interface
Three USB 2.0 Ports
One External Monitor Port
One Headphone-Out Jack
One Microphone-In Jack
One Line-In Jack
One S/PDIF Output Jack

One RJ-11 Jack for Plug & Play Fax/Modem
One RJ-45 Jack for 10Mb/ 100Mb/ 1000Mb Fast
Ethernet
One Mini-IEEE 1394 Port
One S-Video-Out Jack (supports HDTV)
One DC-in Jack

Card Reader Embedded 4-in-1 Card Reader (MS/ MS PRO/ SD/ MMC)

ExpressCard Slot ExpressCard/34/54 Slot

Communication AZALIA 56K Plug & Play Fax/Modem v.90/92 Compliant
10Mb/ 100Mb/ 1000Mb Fast Ethernet
(Option) Intel PRO/Wireless 3945ABG Wireless LAN Module with PCIe Interface
(Factory Option) Bluetooth Module - Version 2.0
(Factory Option) PC Camera with USB Interface

Power
Management Supports ACPI 2.0

Power Button as Sleep/Resume Key
Supports Hibernate Mode
Supports Stand by Mode

Supports Battery Low Suspend
Supports Resume from Modem Ring
Supports Wake on LAN

Feature Specifications

Power Full Range AC/DC Adapter 20V, 3.25A (65 Watts), 100~240V, 47~63Hz
Full Range AC/DC Adapter 20V, 4.5A (90 Watts), 100~240V, 47~63Hz (If Using the Optional Port
Replicator)
6 Cell Smart Lithium-Ion Battery Pack, 4000mAH (44.4W)
OR
6 Cell Smart Lithium-Ion Battery Pack, 4400mAH (48.8W)

Envirnonmental 
Spec Temperature

Operating: 5°C~ 35°C 
Non-Operating: -20°C~60°C

Relative Humidity 
Operating: 20% ~ 80% 
Non-Operating: 10% ~ 90%

Physical 
Dimensions & 
Weight

333mm (w) * 243mm (d) * 24-33mm (h)
2.2 kg Without Battery

Optional
Optical Drive Module Options:
DVD/CD-RW Combo Drive Module
DVD-Dual Drive Module
Port Replicator (10/100 Base-T Ethernet Port, 4 *
USB 2.0 Ports, Serial Port, Parallel Port, External
Monitor Port, DC-In Jack)
(Note: Port Replicator requires the supplied
90W power adapter)

Charger Box
Intel PRO/Wireless 3945ABG Wireless LAN
Module with PCIe Interface
(Factory Option) PC Camera with USB Interface
(Factory Option) Bluetooth Module - Version 2.0
(Factory Option) Swap Battery - 2 ~ 3 Minutes
Swap Time
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